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1. The Computer—An Overview
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A. 1.(a) 2. (b) 3. (@) 4. (a) 5. (c)
B. 1F 2.F 3T 4. F
C. 1 impact 2. webcam 3. joystick 4. pixels 5. Microprocessors
N
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Let's Do It
A. 1. Acomputeris an electronic machine that accepts data given by user, process the data as per
given instructions and produces results.
2. A touch screen is a screen that is sensitive to touch and helps us to interact with computers
by touching the areas on the screen.
3. The motherboard is sometimes called the system board or main circuit board. Many electronic
components are attached to the motherboard or are built into it.
4. A Computer takes the data as input, processes and then gives result as an output.
B. 1. The three main components of CPU are:

e ALU (Arithmetic Logic Unit): Performs mathematical and logical operations.
e CU (Control Unit): Directs all the operations of a processor.
e Memory Unit: Stores data and instructions.

. Limitations of a Computer are:

e Lack of decision making ability
e Lack of intelligence
e Lack of feelings or emotions

. Impact printers create an image on a paper by striking the paper with a metal.

Example: Dot matrix printer.
Non-impact printer create an image on a paper by spraying ink on the paper.
Example: Inkjet printer.
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Input 2. Output 3. Input 4. Input 5. Output 6. Input
Plotters 2. Joystick 3. Speakers 4. Microphone
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2. Computer Memory
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A.
B.
C.
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(a) 2.(0) 3.(b) 4. (c)
Random Access Memory 2. Read only memory 3. Gigabyte 4. USB
Memory Card 2. Hard disk 3. Flash drive 4.DVD 5.RAM
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Hard disk is a secondary storage device that is used to store data permanently.

A memory card is a multimedia memory card that is used in mobiles and digital cameras to
store data.

Type of CD's are: CD ROM, CD-RW, CD-R

Optical disc is an electronic data storage medium that can be written to and read using a
low powered laser beam.

. There are two types of RAM:

(i) Static RAM (i) Dynamic RAM

. Types of Computer Memory:

(i) Primary Memory—It is the main memory of the computer that can be accessed by the
CPU directly. It is fixed on the motherboard. There are two types of Primary memory. RAM
and ROM

(i) Secondary memory—It is the permanent memory that is not directly accessed by the CPU.
I allows users to store data that may be easily retrieved. The secondary memory devices
are Hard disk, CD's , DVD's and Pen drives.

. (i) Pen drive—It acts as a portable hard drive and is easy to use as it is small and can be

carried in a pocket and plugged into any computer with a USB drive.

(ii) Optical disk—An optical disc is an electronic data storage medium that can be written to
and read using a low powered laser beam.

Hard disk Memory card Blu-ray disc 4. Pen drive
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3. Windows 7

A. 1 (a) 2. (b) 3.(a) 4. (o)
B. 1. downloads 2. folder 3. subfolder 4. Windows Explorer
C 1T 2.T 3.F 4. T
D. 1b 2.d 3.e 4. a 5.¢c
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A. 1. Common folders provided by Windows 7 are:
» Documents * Pictures * Music * Videos » Downloads
2. Organised files and folders help us to find the right files to use when we run a program.

3. When we copy and move a file, it is removed from its original location and appear a new
location.

B. 1. File is a folder is collection of various files and sub folders whereas a file is a collection of
related information.

2. Steps to delete a file or folder permanently are:
Step 1 Open the file or folder you want to delete.
Step 2 Click on File or folder
Step 3 Click on Organize
Step 4 Click on Delete
Step 5 Click on Yes
Step 6 The file or folder will be deleted.
3. To rename a file or a folder, follow these steps:
Step 1 Open Windows Explorer and locate the file to be renamed.
Step 2 Click on Organize command on the toolbar.
Step 3 Click on Rename option from the drop-down list.
Step 4 Enter a new name for the file or the folder.
Step 5 Press Enter key.
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Periodic Assessment-1
(Based on chapters 1 to 3)
A.
[ Forward ][Address bar] [ Search ]
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- [s Computer » 7 ~ 49 |[ Search Computer 7 )
Uninstall or change a program Map network drive 0 @

8 Downloads
% Recent Places

44 Libraries
>[4 Documents
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» 18 Computer
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4 Hard Disk Drives (4)
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New Volume ()
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File list
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B. 1. (0 2.(d)

Memory: 146 GB

3.(a)

<
<%

4. (b)

C. Pendrive would be most suitable for their purpose.
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4. Graphics in MS Word 2010
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A. 1 (b 2. (b) 3.(0) 4.(c)
B. 1. Shapes 2. Insert 3. Add text 4. ClipArt 5. WordArt  6.3D
C. 1. Shapes 2. WordArt 3. Pictures 4. Symbol
D. 1T 2.F 3.F 4.7 5.F 6.F
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A. 1. Todraw a shape:
Step 1 Click on Insert tab.
Step 1 Shapes command.
Step 1 Choose designed Shape.
Step 1 Drag in the text area.

2. By clicking on the Fill command in the shape style group in Format tab, we can change the
colour of a shape in MS Word 2010.

3. Symbols are punctuation or special characters generally not found on keyboard.

B. 1. To change outline colour:

Step 1 Click on Shapes present in Format tab.

Step 2 Click on shape outline in shape style group.

Step 3 Choose colour from the drop-down box of colours.

To change the thickness:

Step 1 Click on Format tab.

Step 2 Shape effect command in shape style group.

Step 3 Bevel option.

Step 4 Select desired bevel effect.

2. WordArt allows us to create text effects that can not be inserted through text formatting.
Whereas, ClipArt helps us to insert pre-designed pictures to make our document look
professional.

3. To insert a picture in a document, follow these steps:
Step 1 Place the cursor where you want to insert pictures.
Step 2 Click on Insert tab- Insert picture from illustrations group.
Step 3 Choose the desired picture.
Step 4 Click on Insert button and the picture will be inserted.

Crack \The | Code b4
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5. Word Processor—Tabular Representation

(One Touch 'Learn 2

A. 1.(b) 2. (b) 3. (b) 4. (a)
B. 1.Resizing 2. Merge cells 3. Layout 4. Design 5. Delete Rows
C. L1F 2.7 3.7 4.F 5.F
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A. 1. Itisthe intersection of rows and columns.
2. Table style is a collection of in built table styles.

3. Shading enhances the look and feel of the table.
1. To add a row, follow these steps:

Step 1 Select the row where you want to add another row.

Step 2 Click on the layout tab.

Step 3 Click on Insert Above or Insert Below command. A row will be added.
2. To insert a table, follow these steps:

Step 1 Open the MS Word and click on the Insert tab.

Step 2 Click on the Table command in the Tables group.

Step 3 Move the mouse over the squares to select columns and rows for the table. When

you move the mouse over the squares, a sample table is visible in the document.

3. Splitting cell refers to dividing one cell into two or more cells.

Whereas, Merging cell refers to combining two or more cells in the same row or same column
into a single cell.
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A. 1 Insertabove 2. Insert below 3. Delete 4. Merge cells
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Periodic Assessment-2
(Based on chapters 4 & 5)
A. 1. Shape outline 2. Insert tab 3. Design 4. Cell
B. 1. Insert 2. ClipArt 3. Rows 4. Symbols
C. 1T 2.F 3.7 4. False
D. 1.(d) 2. (a) 3. (b) 4. (c)
E. Table
Test Sheet-1
(Based on chapters 1 to 5)
Section A
A. 1. (i) 2. (ii) 3. () 4. (iii) 5. (ii) 6. (ii)
B. 1. Pixels 2. Platters 3. Sub folder 4. Format
C. L1F 2.F 3.7
D. 1. (d) 2.(c) 3. (a) 4. (b)
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Section B
A. 1. Shape feature is used to insert various ready-made shapes in the word document.

2. It is the main memory of the computer. CPU can directly access this memory. It is fixed on
the Motherboard.

3. Renaming a file means to change the default name of the file and give it a new name as per
your choice

4. Flatbed, Handheld and sheetfed are the different types of scanner.
B. 1. Limitation of computers are:
« Lack of decision making ability
« Lack of intelligence
« Lack of feelings or emotions
2. Different types of printers are:

(i) Dot-matrix printer—It works like a typewriter. The printer head strikes the paper and
ink ribbon to print a character. It is an impact printer.

(ii) Inkjet printer—These are non impact printers. It prints line by line by spraying ink on a
sheet of paper. These printers are much faster than dot matrix printer. These are expensive
and consume more ink.

(iii) Laser printer—These are also non impact printers. IT uses a laser beam to print on the
paper. These are much faster than the inkjet printer and print quality of these printer is
superior.

6. More on MS PowerPoint 2010
(One

A. 1.@© 2@ 3.0 4

B. 1.F 2.F 3.T 4.7
C. 1.Slide 2.Slide layout 3. Reading 4. Saved images 5. Slide show
D. 1. Layout 2. Slide Sorter 3. Notes Page

4. Reading View 5. WordArt
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A. 1. Aslide layout is the arrangement of text, images, clipart and charts etc. on a particular slide.
2. Normal view is used to change the slide layout.
3. List, process and cycle are the three types of SmartArt.
1. To insert SmartArt, follow these steps:
Step 1 Insert tab.
Step 2 Illustration group.
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Step 3 SmartArt command.
Step 4 Choose a graphic type form the left section of dialogue box.
Step 5 Choose design and click OK.

2. WordArt allows you to create text effects that are not available through font formatting. You
can insert WordArt in your slides also. To add WordArt to a slide, follow these steps:
Step 1 Select the text to be converted to a WordArt style.

Step 2 Click on WordArt command in the Text group on the Insert tab. A drop-down menu
appears with different types of WordArt styles.

Step 3 Select the desired style. A textbox will appear in the document.
Step 4 Enter text in the textbox.

3. The different views in PowerPoint are:

(i)  Normal view—This view is the default view of presentation. It shows current slide, outline
and notespane.

(i) Outline view—This view displays the slide in outline format.

(iii) Slide Sorter view—This view shows the miniatures of the slides and allows to change
the order of the slides.

(iv) ReaderView—This view shows the presentation not in full screen but with simple controls
to review the presentation.

crack The. cod 14

1. Slide show 2. WordArt/Text box 3. Notes pane 4. Reading view
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7. Introduction to MS Excel 2010

(One /Touch 'Learn i

A. 1.(0 2.(c) 3.(b) 4. (b)
B. 1. Name box 2.Title 3. Quick Access 4. Formula 5. Worksheet
C. 1F 2.T 3.F 4.F 5. F

Let's Do It

A. 1. Cell range is a collection of two or more cells.
2. Ribbon is a bar that has tabs with groups of related commands displayed in it.
3. This is the currently selected cell that appeared highlights with a dark border.
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B. 1. Formula bar is used to edit and enter formulas. It is also used for entering and editing the
cell contents.

2. A workbook is a collection of different worksheets. By default a worksheet contain 3 sheets
whereas, a worksheet is a single page in excel.

Crack ' The Code %
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Periodic Assessment-3
(Based on chapters 6 & 7)
A. 1. Placeholders 2. Slide Sorter View 3. Slides
4. Workbook 5. Columns 6. Name bar
B. 1.F 2. T 3.F 4. F 5.T
Quick Access| — ¥ | Title bar
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Name box || ™ ¢ w- &-A- == 9 ws ~ | EaFomat~ | @+ Fiters serecte
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1
2 X =
3 Active cell -
4 [ Mouse pointer ]
5
6
Sheettab || o
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D. MS Excel 2010

8. Programming in Scratch
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A. 1.(9 2. (b) 3. (b) 4. (b)
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B. 1. Looks 2. Forever 3. Relational 4. String

C. 1.7 2.F 3.T 4. T 5.7
Let's Do It

A. 1. Variable blocks are used to hold values and strings.
2. Pen up and Pen down are the two blocks of pen category.
B. 1. Arithematic, Logical and Relational are the different operators.
2. (a) Stamp—It duplicates sprites image on to the stage.
(b) Hide—Makes sprite disappear from the stage
(c) Pen up—Puts up sprite’s pen p so that it won't draw as it moves on the screen.

3. Forever block runs the script continuously until stopped. Whereas, if then else block checks
the given condition. If the condition is true the then code inside the first space is activated
else the code inside0 the second space is activated.

crock ihe, code 1

1. Pen block 2. Arithmetic Operator 3. Looks block 4. Variables block
5. Pen block
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9. More on Internet

A. 1 2.(0) 3. (b) 4. (a)

B. 1. information 2.search engine 3. downloading 4. uploading
C. L1F 2.7 3.7 4.F

D. 1. (o) 2. (a) 3.(d) 4. (b)

E. 1. Goggle chrome 2. Internet Explorer 3. Mozilla Firefox
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A. 1. Internet is a network in which millions of computers are connected one another to share
information.

2. Facebook, Twitter and Instagram are three social networking websites.
3. Getting data from the host computer to the client computer is called as downloading.
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B. 1. Uses of internet are:
«  We can buy and sell goods online.
» We can search information on any topic.

2. ISP is a company that provides internet access to people on payment of a monthly fees like

Airtel, Vodafone etc.

3. Telephone lines and cables, Modem, Computer System, web browser and ISP are the things

required to connect to Internet.

crack ihe cod L}

1. URL 2. Surfing 3. Telephone and Cable lines
(14
[FUN [in [ LaB =1
Do yourself.
[ [
Periodic Assessment-4
(Based on chapters 8 &9)
A. 1. Looks 2. Looks 3. Pen 4. Operator
B. 1. (d) 2. (a) 3. (b) 4. (c)
C. 1. INFORMATION 2. DOWNLOADING
3. ONLINE CHAT 4. UPLOADING
D. 1. Arithmetic operator 2. Relational Operator 3. Logical Operator
Test Sheet-2
(Based on chapters 6 to 9)
Section A
A. 1 () 2. (i) 3. (iii) 4. (i)
B. 1. Slides 2. Slide Show 3. Worksheet 4. String
C 1T 2. F 3.F 4.7
D. 1 (o 2.(d) 3.(a) 4. (e)
Section-B

A. 1. Itis cell which have dark black border around it.

2. Itis an application software that helps us to access internet.

5.If then else

4. Internet/Web browser

6. Forever

3. Title bar, Ribbon, Name box, Quick Access toolbar, Formula bar, Cell, Rows and columns,

sheet tabs, Scroll bars, Active cell,

4. Slide layout refers to the way of arranging objects on a slide.

5. Internet can be used to buy and sell thing online and send and receive messages.

1

N
o 12 STouchpad PLUS (Version 1.0)-V (Answer Key)

S—

LA



B. 1. The different views in PowerPoint are:
(i) Normal view—This view is the default view of presentation. It shows current slide, outline
and notes pane.
(i) Outline view—This view displays the slide in outline format.
(iii) Slide Sorter view—This view shows the miniatures of the slides and allows to change
the order of the slides.
(iv) Reader View—This view shows the presentation not in full screen but with simple controls
to review the presentation.
2. Stamp block duplicates the sprite’s image on the stage.
3. Computer system, Telephone and cable lines, Web browser, ISP and Modem are required to
connect to Internet.
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